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Administratorhandbuch

Die folgenden Anweisungen gelten fiir Administratoren an Standorten mit dem Lizenztyp Lizenz fiir
gleichzeitig angemeldete Benutzer fiir IBM® SPSS Amos 24. Mit dieser Lizenz kénnen Sie IBM SPSS
Amos auf beliebig vielen Computern installieren. Allerdings hingt die Anzahl der Benutzer, die die An-
wendung gleichzeitig ausfiihren kénnen, davon ab, fiir wie viele Personen die Lizenz erworben wurde.

Vorbereitungen

Sie benétigen Thren Autorisierungscode. Mit dem Autorisierungscode konnen Sie eine Lizenz fiir den
Concurrent License Manager anfordern. Der Concurrent License Manager steuert die Lizenz fiir gleich-
zeitig angemeldete Benutzer und ermdglicht den Endbenutzern die Ausfithrung von IBM SPSS Amos.

Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscodes erhalten haben. Wenn Sie den
Autorisierungscode nicht finden konnen, wenden Sie sich an den Kundendienst. Rufen Sie hierzu die Sei-
te |http:/ /www.ibm.com /software /analytics /spss/support/clientcare.html| auf.

Fiihren Sie die folgenden Schritte aus, um sicherzustellen, dass Sie die Lizenz fiir gleichzeitig angemelde-
te Benutzer ordnungsgemafs eingerichtet haben:

1.

Installieren Sie den Concurrent License Manager. Der Concurrent License Manager ist ein Dienst-
programm, das Endbenutzern die Lizenz fiir gleichzeitig angemeldete Benutzer bereitstellt. Sie kénnen
den Lizenzmanager auf einem beliebigen Computer in Threm Netz speichern. In der Regel handelt es
sich dabei um einen Server, an den Desktop-Computer angeschlossen werden kénnen. Weitere Infor-
mationen finden Sie im Thema |,Installieren des Concurrent License Managers” auf Seite 2|

Lizenzieren Sie das Produkt. Mit diesem Vorgang erhilt der Lizenzmanager die fiir die Ausgabe der
Lizenzen erforderlichen Informationen. Weitere Informationen finden Sie im Thema [Produktlizenzie-|

Testen Sie den Concurrent License Manager. Sie sollten den Lizenzmanager testen, um sicherzustel-
len, dass er Lizenzen bereitstellt. Weitere Informationen finden Sie im Thema
[Lizenzmanagers” auf Seite 9}

Installieren Sie IBM SPSS Amos auf den lokalen Desktop-Computern. Sie oder Ihre Endbenutzer
fiihren die vollstdndige Installation auf den Desktop-Computern durch. Wéahrend der Installation
kann der Endbenutzer den Computer angeben, auf dem der Lizenzmanager ausgefiihrt wird. Wenn
ein Endbenutzer versucht, IBM SPSS Amos zu starten, fordert das Produkt bei diesem Lizenzmanager
einen Lizenzcode an. Wenn eine Lizenz verfligbar ist, wird IBM SPSS Amos gestartet. Weitere Infor-
mationen finden Sie im Thema [, Installieren des Produkts auf lokalen Desktop-Computern” auf Seite]

Fiir die Installation sind keine administrativen Schritte erforderlich. Sollten jedoch Probleme auftreten,
finden Sie in |, Verwalten der Lizenz fiir gleichzeitic angemeldete Benutzer” auf Seite 13| weitere Informa-
tionen.

Erstellen eines Image

Sie kénnen ein Image der Software erstellen, indem Sie den Lizenzmanager installieren und das Produkt
anschlieffend auf einem lokalen Desktop installieren, der zum Erstellen eines Images verwendet wird. Er-
stellen Sie nach Bedarf Images von zusatzlichen Computern.

Citrix- und Terminaldienste

Sie konnen die Anwendung IBM SPSS Amos auf dieselbe Art auf dem Citrix- bzw. Terminaldienst-Server
installieren und den Benutzern zuginglich machen, auf die Sie andere Anwendungen fiir Windows instal-
lieren und zuganglich machen.


http://www.ibm.com/software/analytics/spss/support/clientcare.html

Installieren des Concurrent License Managers

Bevor Endbenutzer IBM SPSS Amos auf ihrem Desktop-Computer installieren, miissen Sie den Concur-
rent License Manager installieren. Dieses Dienstprogramm ist ein fortlaufend ausgefiihrter Service oder
Déamonprozess, der in der Regel auf einem Computer im Netz installiert wird. (Sie haben auch die Mog-
lichkeit, ihn auf mehreren Computern zu installieren, wobei Sie redundante Lizenzmanager einrichten
miissen. Weitere Informationen finden Sie im Thema |,,Einrichten von redundanten Lizenzservern” auﬂ
) Der Concurrent License Manager wird nicht auf den Desktop-Computern der Endbenutzer ins-
talliert.

Immer wenn ein Endbenutzer eine der Lizenz fiir gleichzeitig angemeldete Benutzer unterliegende IBM
SPSS-Anwendung startet, fordert die Anwendung eine Lizenz vom Lizenzmanager an. Dieses Dienstpro-
gramm gibt Lizenzen bis zu einer festgelegten Anzahl gleichzeitiger Endbenutzer aus, die sich aus der
von Thnen erworbenen Lizenz ergibt. Wenn diese Anzahl erreicht ist, werden weitere Anfragen nach Li-
zenzen zurilickgewiesen. Wenn Sie feststellen, dass Endbenutzern haufig Lizenzen verweigert werden, er-
kundigen Sie sich bei dem fiir Sie zustdndigen Handler nach einer Lizenz fiir eine grofierer Anzahl
gleichzeitiger Benutzer.

Lizenzmanager sind auf einer separaten DVD/CD verfiigbar. Sie konnen auch als elImage heruntergela-
den werden.

Anmerkung: Der Lizenzmanager zeichnet die Anzahl aktiver Endbenutzersitzungen sowie Informationen
zu diesen einzelnen Sitzungen in einer Protokolldatei auf, die Sie dann zur Fehlerbehebung bei Verbin-
dungsproblemen heranziehen konnen. Weitere Informationen finden Sie im Thema

Protokollinformationen” auf Seite 14}

Mehrere Betriebssysteme

Die Plattform, auf der der Concurrent License Manager ausgefiihrt wird, muss nicht mit der Plattform
tibereinstimmen, auf der der Client aktiv ist. Zum Beispiel kann ein Linux-Lizenzmanager Lizenzen fiir
Windows-Clients bereitstellen.

Verwalten des Lizenzmanagers

Der Lizenzmanager wird mithilfe des Lizenzmanageradministrators verwaltet, der nur fiir Windows ver-
fiigbar ist. Beachten Sie deshalb, dass Sie mindestens einen Windows-System benétigen, auf dem der Li-
zenzmanageradministrator installiert ist.

Systemanforderungen

Der Computer, auf dem der Concurrent License Manager installiert werden soll, muss die folgenden An-
forderungen erfiillen. Fiir den Lizenzmanager ist kein Serverklassencomputer erforderlich.

* Prozessor mit mindestens 500 Mhz
¢ Mindestens 128 MB RAM

Wichtig: Wenn auf dem Computer, auf dem der Lizenzmanager installiert ist, eine Firewall aktiv ist,
miissen Sie Port 5093 fiir UDP 6ffnen. Andernfalls konnen die Client-Computer keine Lizenz vom Lizenz-
manager abrufen. Wenn Sie dariiber hinaus redundante Lizenzmanagercomputer verwenden, miissen Sie
Port 5099 fiir UDP 6ffnen, damit die Lizenzmanagercomputer untereinander kommunizieren kénnen.

Durchfiihren eines Upgrades fiir den Lizenzmanager

Wenn Sie eine friihere Version des Lizenzmanagers installiert haben, miissen Sie die folgenden Schritte
durchfiihren:

1. Wechseln Sie in das Verzeichnis, in dem Sie den alten Lizenzmanager installiert haben.
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Kopieren Sie die Datei Iservrc. Windows: Suchen Sie im Verzeichnis winnt.
Speichern Sie die Datei Iservrc an einem sicheren Ort.
Falls Benutzer Pendlerlizenzen ausgecheckt haben, stellen Sie sicher, dass diese Lizenzen wieder ein-

gecheckt werden. Informationen zum Abrufen einer Liste der ausgecheckten Lizenzen finden Sie im
Thema |, Konfigurieren von Pendlerlizenzen” auf Seite 16|

Fahren Sie den Lizenzmanager herunter. Weitere Informationen finden Sie im Thema |, Starten und
[Stoppen des Lizenzmanagers” auf Seite 19|

Deinstallieren Sie den alten Lizenzmanager. Weitere Informationen finden Sie im Thema |, Deinstallie
fren des Lizenzmanagers” auf Seite 20}

Installieren Sie den neuen Lizenzmanager. Informationen zum Installieren unter Windows finden Sie
im Thema [, Installieren des Lizenzmanagers unter Windows”| Informationen zum Installieren unter
UNIX/Linux finden Sie im Thema |,,Installieren des Lizenzmanagers unter UNIX/Linux”| Weitere In-
formationen zum Installieren unter Mac OS finden Sie in |, Installieren des Lizenzmanagers unter Mad|

OS” auf Seite 4

Kopieren Sie die gespeicherte Datei Iservrc in das Verzeichnis, in dem Sie den neuen Lizenzmanager
oder das Unterverzeichnis winnt des Installationsverzeichnisses unter Windows installiert haben.
Wenn Sie den Standardspeicherort unter Windows akzeptiert haben, wechseln Sie in den Ordner C:\
Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager.

Installieren des Lizenzmanagers unter Windows

Anmerkung: Sie miissen das Installationsprogramm als Administrator starten. Wenn Sie aufgefordert
werden, eine Installationsdatei zu starten, klicken Sie mit der rechten Maustaste auf die Datei und wahlen
Als Administrator ausfithren aus.

Anmerkung: Stellen Sie sicher, dass auf dem Computer, auf dem Sie die Installation durchfiihren, Java
installiert ist.

1.

2.

Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie nach dem Win-
dows Installer fiir den Lizenzmanager und starten Sie ihn von der DVD/CD.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, kénnen Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem elmage extrahieren. Starten Sie die Datei des Installati-
onsprogramms fiir Thr Betriebssystem.

Folgen Sie den am Bildschirm angezeigten Anweisungen.

Installieren des Lizenzmanagers unter UNIX/Linux

1.

S A

Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie nach der Lizenz-
managerdatei fiir Ihr Betriebssystem.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

Entpacken Sie die Datei des Lizenzmanagers.
Fiihren Sie die extrahierte TAR-Datei aus.
Folgen Sie den am Bildschirm angezeigten Anweisungen.

Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie im Thema |, Installieren des Lizenzmanageradministrators” auf Seite 4]

Weitere Informationen zum Starten des Lizenzmanagers finden Sie in [, Starten und Stoppen des|
[Lizenzmanagers” auf Seite 19}
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Installieren des Lizenzmanagers unter Mac OS

1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie nach der Lizenz-
managerdatei fiir Ihr Betriebssystem.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

Doppelklicken Sie auf die ZIP-Datei des Lizenzmanagers, um den Inhalt der Datei zu entpacken.
Doppelklicken Sie auf das entpackte Installationsprogramm des Lizenzmanagers.
Folgen Sie den am Bildschirm angezeigten Anweisungen.

A

Installieren Sie die Lizenzmanagertools auf einem Windows-System. Weitere Informationen finden Sie
im Thema |, Installieren des Lizenzmanageradministrators”}

6. Weitere Informationen zum Starten des Lizenzmanagers finden Sie in [,Starten und Stoppen des|
[Lizenzmanagers” auf Seite 19|

Installieren des Lizenzmanageradministrators

Der nur fiir Windows verfiigbare Lizenzmanageradministrator wird fiir die Verwaltung des Lizenzmana-
gers verwendet. Je nach Betriebssystem miissen Sie diese Anwendung gegebenenfalls manuell installieren.

*  Windows. Der Lizenzmanageradministrator wird automatisch auf dem gleichen System installiert, auf
dem Sie auch den Lizenzmanager installiert haben. Sie kénnen die Installation auch auf einem anderen
Windows-System vornehmen, wenn Sie den Lizenzmanager remote verwalten méchten.

* Andere Betriebssysteme. Wenn Sie den Lizenzmanager auf einem Nicht-Windows-System installiert
haben, miissen Sie die Lizenzmanagertools auf einem Windows-System installieren.
1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des
Netzcomputers ein, auf dem der Lizenzmanageradministrator ausgefithrt werden soll. Suchen Sie

nach dem Windows Installer fiir den Lizenzmanageradministrator und starten Sie ihn von der DVD/
CD.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, kénnen Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem elmage extrahieren. Starten Sie die Installationsdatei des
Lizenzmanageradministrators.

2. Folgen Sie den am Bildschirm angezeigten Anweisungen.

Produktlizenzierung

Klicken Sie nach dem Abschluss des Hauptteils der Installation auf Fertigstellen, um den Lizenzautorisie-
rungsassistenten zu starten. Mit dem Lizenzautorisierungsassistenten kénnen Sie eine Lizenz fiir IBM
SPSS Amos anfordern. Bei anderen Betriebssystemen miissen Sie die Lizenz nach der Installation des Li-
zenzmanagers iiber die Eingabeaufforderung installieren.

Wenn Sie jetzt keine Lizenz beziehen, kénnen Sie IBM SPSS Amos fiir einen bestimmten Zeitraum fiir die
temporédre Verwendung aktivieren, in dem das Produkt von einer begrenzten Anzahl an Personen ver-
wendet werden kann. Nach Ablauf des Zeitraums fiir die temporédre Verwendung, der mit der ersten
Nutzung des Produkts beginnt, kann IBM SPSS Amos nicht mehr ausgefiihrt werden. Daher sollten Sie so
schnell wie moglich einen Lizenzcode anfordern. Sie miissen entweder eine Lizenz einholen oder eine
Aktivierung fiir die temporédre Verwendung durchfiihren, um IBM SPSS Amos zu verwenden.

Anmerkung: Lizenzen sind mit einem Sperrcode an die physische oder virtuelle Hardware des Netzcom-
puters gebunden. Wenn Sie den Netzcomputer oder die zugehorige Hardware austauschen, benotigen Sie
einen neuen Sperrcode und miissen bei Ihrem Vertriebsbeauftragten einen neuen Autorisierungscode an-
fordern. Bei Installationen auf einer virtuellen Maschine miissen Sie sicherstellen, dass Sie einen Sperr-
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code auswihlen, der sich beim Neustart nicht dndert. Weitere Informationen finden Sie in |, Installiere
kiner Lizenz in einer virtuellen Umgebung”}

Wichtig: Die Lizenz reagiert auf Anderungen der Systemzeit. Wenn Sie die Systemzeit dndern miissen
und dann das Produkt nicht mehr ausfiihren konnen, fordern Sie Unterstiitzung durch das Kunden-
betreuungsteam tiiber die Seite lhttp:/ /www.ibm.com /software /analytics/spss /support/clientcare.html|
an.

Installieren einer Lizenz in einer virtuellen Umgebung

Es gibt spezielle Lizenzierungsanweisungen fiir Installationen des Concurrent License Managers in einer
virtuellen Umgebung. Bei einer virtuellen Maschine ist die Hardware virtuell und der Sperrcode, mit dem
der Lizenzmanager an die Lizenz gebunden ist, kann sich beim Neustart der virtuellen Maschine &ndern.
Sie miissen einen Sperrcode finden, der sich beim Neustart der virtuellen Maschine nicht dndert, um si-
cherzustellen, dass der Lizenzmanager ordnungsgemafs funktioniert. Wenn Sie einen stabilen Sperrcode
finden, verwenden Sie ihn fiir die Lizenzierung des Lizenzmanagers.

Wichtig:

Wenn Sie einen Sperrcode auswihlen, der sich beim Neustart dndert, funktioniert der Lizenzmanager
nicht mehr. Die IBM SPSS-Anwendung kann keine Lizenz abrufen und daher nicht gestartet werden.

Priifen des Sperrcodes
1. Offnen Sie eine Eingabeaufforderung.
2. Wechseln Sie in das folgende Verzeichnis.

* Windows. Das Unterverzeichnis winnt des Installationsverzeichnisses fiir den Lizenzmanager. Wenn
Sie den Standardspeicherort wahrend der Installation akzeptiert haben, lautet das Installationsver-
zeichnis fiir den Lizenzmanager C:\Programme\IBM\SPSS\Concurrent Licensing
Tools\<Version>\License Manager.

* Andere Plattformen. Das Installationsverzeichnis fiir den Lizenzmanager.
3. Geben Sie an der Eingabeaufforderung echoid (Windows) oder ./echoid (andere Plattformen) ein.

Es wird eine Ausgabe dhnlich der folgenden angezeigt:

(Locking Code 1 : 4-12A1B )

Die unmittelbar vor dem Bindestrich (-) angezeigte Zahl ist das Sperrcodekriterium. Das Sperrcodekriteri-
um ist eine Zahl, die die virtuelle Hardware darstellt, die fiir den Sperrcode verwendet wird (in diesem
Beispiel ist dies 4 und stellt die Datensatz-ID des Datentrégers mit dem Betriebssystem dar). Die Zahl
hinter dem Bindestrich ist der Sperrcode (in diesem Beispiel ist dies 12A1B).

Mogliche Sperrcodekriterien:

Sperrcodekriterium Virtuelle Hardware

2 IP-Adresse

4 Datensatz-ID des Datentrdgers mit dem Betriebssystem
8 Hostname

10 Ethernet-Karte

Prifen, ob der Sperrcode stabil ist
1. Starten Sie die virtuelle Maschine nach der Priifung des Sperrcodes neu.

2. Priifen Sie den Sperrcode erneut (siehe [, Priifen des Sperrcodes”).
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* Wenn sich der Sperrcode nicht dndert, starten Sie neu und priifen Sie den Sperrcode mehrmals.
Wenn der Sperrcode stabil ist, kénnen Sie die Lizenzierung durchfiihren (siehe |,Lizenzierung des|
[Lizenzmanagers mit dem neuen Sperrcode”).

« Wenn sich der Sperrcode d@ndert, miissen Sie ihn aktualisieren (siehe [, Aktualisierung des Sperr-|

feodes™).

Aktualisierung des Sperrcodes
1. Offnen Sie die Datei echoid.dat, die sich im folgenden Verzeichnis befindet, in einem Texteditor.

* Windows. Das Unterverzeichnis winnt des Installationsverzeichnisses fiir den Lizenzmanager. Wenn
Sie den Standardspeicherort wiahrend der Installation akzeptiert haben, lautet das Installationsver-
zeichnis fiir den Lizenzmanager C:\Programme\IBM\SPSS\Concurrent Licensing
Tools\<Version>\License Manager.

* Andere Plattformen. Das Installationsverzeichnis fiir den Lizenzmanager.

2. Es wird eine Hexadezimalzahl angezeigt, die das aktuelle Sperrcodekriterium darstellt. Andern Sie
diese Zahl in ein zulédssiges Sperrcodekriterium im Hexadezimalformat.

Sperrcodekriterium im Hexadezimalformat Virtuelle Hardware

0x002 IP-Adresse

0x004 Datensatz-ID des Datentrdgers mit dem Betriebssystem
0x008 Hostname

0x010 Ethernet-Karte

Lizenzierung des Lizenzmanagers mit dem neuen Sperrcode

Wenn Sie einen stabilen Sperrcode gefunden und eine entsprechende Aktualisierung durchgefiihrt haben,
gibt es keine weiteren spezifischen Lizenzierungsschritte fiir virtuelle Umgebungen. Beenden Sie die Ins-
tallation der Lizenz mithilfe des Lizenzautorisierungsassistenten oder iiber die Eingabeaufforderung.

Verwenden des Lizenzautorisierungsassistenten (nur Windows)

Hinweis: Moglicherweise werden Sie zur Angabe von Administratorberechtigungsnachweisen aufgefor-
dert. Ohne die entsprechenden Berechtigungsnachweise konnen Sie den Lizenzautorisierungsassistenten
nicht ausfiihren.

1. Wenn Sie den Lizenzautorisierungsassistenten nicht wahrend der Installation starten oder den Lizenz-
autorisierungsassistenten abbrechen, bevor eine Lizenz erworben wurde, konnen Sie ihn durch Aus-
fiihrung der Datei law.exe starten, die Sie im Installationsverzeichnis des Lizenzmanagers finden. Sie
miissen den Lizenzautorisierungsassistenten als Administrator ausfiihren. Klicken Sie mit der rechten
Maustaste auf die Datei law.exe und wiahlen Sie Als Administrator ausfiihren aus.

2. Wenn Sie dazu aufgefordert werden, wéhlen Sie Produkt jetzt lizenzieren. Wenn Sie stattdessen eine
Aktivierung fiir die temporére Verwendung durchfithren méchten, finden Sie in [, Aktivieren fiir diel
[femporire Verwendung” auf Seite 8| weitere Informationen.

3. Geben Sie im entsprechenden Dialogfenster einen oder mehrere der Autorisierungscodes ein.

Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscodes erhalten haben. Wenn Sie
den Autorisierungscode nicht finden konnen, wenden Sie sich an den Kundendienst. Rufen Sie hierzu
die Seite |http:/ /www.ibm.com /software /analytics /spss/support/clientcare.html| auf.

Der Lizenzautorisierungsassistent sendet Ihren Autorisierungscode iiber das Internet an IBM und ruft
Ihre Lizenz automatisch ab. Wenn sich Thr Computer hinter einem Proxy befindet, klicken Sie auf Proxy-
Einstellungen konfigurieren und geben Sie die entsprechenden Einstellungen an.
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Wenn der Autorisierungsvorgang nicht erfolgreich endet, werden Sie aufgefordert, eine E-Mail zu senden.
Geben Sie dann an, ob die E-Mail iiber Ihr Desktop-E-Mail-Programm oder iiber eine webbasierte E-Mail-
Anwendung versendet werden soll.

* Wenn Sie sich fiir die Desktopoption entschieden haben, wird automatisch eine neue Nachricht mit den
entsprechenden Informationen erstellt.

* Wenn Sie sich fiir die webbasierte Option entschieden haben, miissen Sie zuerst eine neue Nachricht in
Ihrem Web-basierten E-Mail-Programm erstellen. Kopieren Sie dann den Nachrichtentext aus dem Li-
zenzautorisierungsassistenten und fligen Sie ihn in Ihre E-Mail-Anwendung ein.

Versenden Sie die E-Mail und reagieren Sie auf die Eingabeaufforderung des Lizenzautorisierungsassis-
tenten. Die E-Mail wird praktisch sofort verarbeitet. Klicken Sie auf Lizenzcode(s) eingeben, um erhalte-
ne Lizenzcodes einzugeben. Wenn Sie den Lizenzautorisierungsassistenten bereits geschlossen haben, star-
ten Sie ihn neu und wihlen Sie Jetzt mein Produkt lizenzieren. Fiigen Sie im Bereich "Codes eingeben"
den erhaltenen Lizenzcode hinzu und klicken Sie auf Weiter, um den Vorgang abzuschliefsen.

Installieren einer Lizenz lGiber die Eingabeaufforderung

Sie haben zwei Moglichkeiten zur Installation iiber die Eingabeaufforderung. Sie kénnen mithilfe von [i-
censeactivator automatisch eine Lizenz aus dem Internet abrufen oder Sie konnen mithilfe von echoid
manuell eine Lizenz beziehen.

Verwenden von licenseactivator zur automatischen Installation einer Lizenz

Der Computer, auf dem Sie die Lizenz installieren, muss mit dem Internet verbunden sein. Andernfalls
miissen Sie die Lizenz manuell installieren. Weitere Informationen finden Sie im Thema [,Manuelles Ins-|
tallieren einer Lizenz” auf Seite 8}

1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.

2. Offnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-
nagers. Dies ist das Verzeichnis, in dem Sie den Lizenzmanager installiert haben, nicht das Installations-
verzeichnis von IBM SPSS Amos. Wenn Sie den Standardspeicherort unter Windows akzeptiert haben,
wechseln Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License
Manager.

3. Nur unter Windows. Wechseln Sie in das Unterverzeichnis winnt.

4. Normalerweise sind Sie im Besitz eines Autorisierungscodes. Im einfachsten Fall geben Sie Folgendes
an der Eingabeaufforderung ein. (Weitere Details zur Verwendung der Befehlszeile finden Sie unten.)

licenseactivator <Autorisierungscode>
Dabei ist <Autorisierungscode> Thr Autorisierungscode.

Es sollte eine Nachricht angezeigt werden, dass die Lizenz erfolgreich hinzugefiigt wurde. Andernfalls
notieren Sie sich den Fehlercode und versuchen Sie, die Lizenz manuell zu installieren. Weitere Informati-
onen finden Sie im Thema |, Manuelles Installieren einer Lizenz” auf Seite 8|

Bei Verwendung von licenseactivator wird das Produkt lizenziert und eine Protokolldatei in das Pro-
duktverzeichnis geschrieben. Der Name der Protokolldatei ist licenseactivator_<Monat>_<Tag>_<Jahr>.log.
Wenn Fehler auftreten, konnen Sie gegebenenfalls der Protokolldatei weitere Informationen entnehmen.
Diese Informationen sind auch dann hilfreich, wenn Sie sich an den IBM Support wenden.

Verwenden von licenseactivator mit Autorisierungscodes

licenseactivator wird in der Regel mit einem oder mehreren Autorisierungscodes verwendet, die Sie beim
Kauf des Produkts erhalten haben. Geben Sie den gesamten Text in einer einzigen Zeile ein.

[PROXYPORT=Proxy-Portnummer] [PROXYUSER=Proxy-Benutzer-ID] [PROXYPASS=Proxy-Kennwort]
* Mehrere Autorisierungscodes werden durch Doppelpunkte (:) getrennt.
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* Die Proxy-Einstellungen sind optional, aber sie sind unter Umstédnden notig, wenn sich Ihr Computer
hinter einem Proxy befindet. Welche Proxy-Einstellungen benétigt werden, hiangt von der jeweiligen
Proxy-Konfiguration ab. Moglicherweise sind alle erforderlich.

PROXYHOST
Der Servername oder die IP-Adresse des Proxy-Hosts

PROXYPORT
Die Portnummer fiir die Internetverbindung tiber den Proxy

PROXYUSER
Falls erforderlich, die Benutzer-ID fiir den Proxy.

PROXYPASS
Falls erforderlich, das Kennwort fiir die Benutzer-ID

Verwenden von licenseactivator mit Lizenzcodes

Eventuell hat Thnen IBM eine Lizenz gesendet.

* Mehrere Lizenzcodes werden durch Doppelpunkte (:) getrennt.

* Bei Verwendung von Lizenzcodes stellt licenseactivator keine Verbindung zum Internet her, sodass Sie
keine Proxy-Informationen angeben miissen.

Manuelles Installieren einer Lizenz

1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.

2. Offnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-
nagers. Beachten Sie, dass dies der Ordner ist, in dem Sie den Lizenzmanager installiert haben, nicht
das Installationsverzeichnis von IBM SPSS Amos. Wenn Sie den Standardspeicherort unter Windows
akzeptiert haben, wechseln Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\
<Version>\License Manager.

3. Nur unter Windows. Wechseln Sie in das Unterverzeichnis winnt.

4. Rufen Sie den Sperrcode fiir den Server-Computer ab. Geben Sie an der Eingabeaufforderung echoid
(Windows) oder ./echoid (andere Plattformen) ein.

5. Rufen Sie unsere regionale Niederlassung an oder senden Sie eine E-Mail an spsscs@us.ibm.com und
teilen Sie IBM den Sperrcode und Ihren Autorisierungscode mit. IBM wird Ihnen anschlieffend einen
Lizenzcode oder eine Datei mit dem Lizenzcode bereitstellen.

6. Verwenden Sie licenseactivator zur Eingabe des bzw. der Lizenzcodes.

Aktivieren fur die temporare Verwendung

Wenn Sie die Lizenz nicht installiert haben, konnen Sie IBM SPSS Amos fiir die tempordre Verwendung
aktivieren.

1. Wenn Sie tiber Installationsdatentrager verfiigen, stellen Sie sicher, dass sich die DVD/CD im DVD/
CD-Laufwerk befindet. Wenn Sie ein elmage heruntergeladen haben, 6ffnen und/oder extrahieren Sie
den Inhalt des elmage.

2. Starten Sie die Anwendung WImAdmin. Weitere Informationen finden Sie im Thema |, Starten der An-|
wendung WImAdmin” auf Seite 14}

3. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Subnet
Servers. Wenn der Lizenzmanagerserver nicht angezeigt wird, geben Sie den Computer an, indem Sie
im Menii "Edit" die Option Defined Server List auswéhlen.

4. Klicken Sie mit der rechten Maustaste auf den Netzcomputer, auf dem der Lizenzmanager ausgefiihrt
wird, und wihlen Sie dann die folgenden Befehle aus:

Add Feature > From a File > To Server and its File
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Hinweis: Wenn Sie To Server auswihlen anstatt To Server and its File, werden die Informationen zur
temporédren Verwendung im Arbeitsspeicher gespeichert. Diese Informationen gehen beim Neustart
des Netzcomputers verloren.

5. Geben Sie im Dialogfeld "Open" den Pfad D:\Windows\Administration\Licensing\
NeworkLicenseManager\1servrc.temp ein. Dabei steht D fiir das Laufwerk Thres Installationsdatentra-
gers. Wenn D nicht das Laufwerk Ihres Installationsdatentrédgers ist, geben Sie den entsprechenden
Laufwerkbuchstaben ein. Wenn Sie ein elmage heruntergeladen haben, geben Sie
<eImage>\Administration\Licensing\NeworkLicenseManager\1servrc.temp ein. Dabei steht <elmage>
fiir den Speicherort, an dem Sie die elmage-Dateien geoffnet/extrahiert haben.

6. Klicken Sie auf OK, wenn die Anwendung Thre Lizenz anzeigt. Informationen zum Anzeigen der Li-
zenzdetails finden Sie in [, Anzeigen der Details zu einer Lizenz” auf Seite 14}

Hinzuflgen einer Lizenz

Eventuell mochten Sie zu einem spéteren Zeitpunkt eine Lizenz hinzufiigen. Der Vorgang beim Hinzufii-
gen einer Lizenz ist identisch mit der Installation der originalen Lizenz.

Anzeigen der Lizenz

Sie konnen IThre Lizenz fiir gleichzeitig angemeldete Benutzer (einschlieilich der Anzahl der Benutzer) in
der Anwendung WImAdmin anzeigen. Informationen zur Anwendung WImAdmin und die Besonderhei-
ten beim Anzeigen der Lizenz finden Sie in [,Verwalten der Lizenz fiir gleichzeitig angemeldete Benutzer”|

huf Seite 13

Testen des Lizenzmanagers

Um sicherzustellen, dass der Lizenzmanager die Lizenzen korrekt bereitstellt, sollten Sie ihn testen.

1. Wenn Sie den Lizenzmanageradministrator nicht auf einem anderen System installiert haben, installie-
ren Sie ihn auf einem Windows-System, auf dem der Lizenzmanager, den Sie testen mochten, nicht
lauft. Weitere Informationen finden Sie im Thema |, Installieren des Lizenzmanageradministrators” auf]

2. Installieren Sie einen weiteren Lizenzmanager auf einem Windows-System, auf dem der Lizenzmana-
ger, den Sie testen mochten, nicht lduft. Weitere Informationen finden Sie im Thema [, Installieren des|
[Lizenzmanagers unter Windows” auf Seite 3}

3. Starten Sie die Anwendung WImAdmin. Weitere Informationen finden Sie im Thema |, Starten der An-|
[wendung WImAdmin” auf Seite 14}

4. Figen Sie den fernen Server des Lizenzmanagers hinzu, den Sie testen mochten. Weitere Informatio-
nen finden Sie im Thema |,Hinzufiigen eines Servers” auf Seite 14}

5. Zeigen Sie die Lizenzen auf dem fernen Server an. Weitere Informationen finden Sie im Thema
[zeigen der Details zu einer Lizenz” auf Seite 14}

Wenn Sie die Lizenzen anzeigen konnen, ist der Lizenzmanager bereit, dass lokale Desktop-Computer an-
geschlossen werden. Sie kdnnen mit der Installation des Produkts auf lokalen Desktop-Computern begin-
nen. Wenn Sie die Lizenzen nicht anzeigen kénnen, {iberpriifen Sie die vorhergehenden Schritte, um si-
cherzustellen, dass der Lizenzmanager korrekt installiert wurde.

Installieren des Produkts auf lokalen Desktop-Computern

Anmerkung: Die Verbindung mit dem Concurrent License Manager iiber VPN wird nicht offiziell unter-
stiitzt.
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Fiir die lokale Installation des vollstaindigen Produkts auf den Computern der Endbenutzer stehen Ihnen
zwei Optionen zur Verfiigung: Sie kdnnen auf jedem Computer eine manuelle Installation durchfiihren
oder eine Anwendung wie Systems Management Server (SMS) verwenden, um die Installation auf Win-
dows-Computern durchzufiihren.

Durchfiihren einer manuellen Installation auf einem lokalen Desktop-Computer

1. Stellen Sie die Installationsmedien zur Verfiigung. Laden Sie das elmage fiir das Produkt herunter
und extrahieren Sie die Dateien auf einem freigegebenen Netzlaufwerk. Wenn Sie tiber Installationsda-
tentrdger verfiigen, erstellen Sie die bendtigte Anzahl von Kopien der DVD/CD oder speichern Sie
die entsprechenden Dateien auf einem freigegebenen Netzlaufwerk

2. Kopieren Sie die Installationsanweisungen und bereiten Sie die Lizenzinformationen vor. Erstellen
Sie die benétigte Anzahl von Kopien der Installationsanweisungen fiir das Produkt. Die Installations-
anweisungen stehen auf der Download-Site bzw. im Falle von physischen Installationsmedien im Ver-
zeichnis auf der DVD/CD zur Verfiigung. Suchen Sie nach den Anweisungen, die Ihrem Lizenztyp
entsprechen. Nach der Installation miissen die Endbenutzer die IP-Adresse oder den Namen des
Netzcomputers eingeben, auf dem der Concurrent License Manager ausgefiihrt wird. Tragen Sie diese
Informationen an der dafiir vorgesehenen Stelle am Anfang der Anweisungen ein, bevor Sie diese ko-
pieren.

3. Verteilen Sie die Installationsunterlagen und -medien an die Endbenutzer. Verteilen Sie die herun-
tergeladene Datei (bzw. den Netzspeicherort oder die Installations-DVD/CD), die Installationsanwei-
sungen und die Lizenzinformationen an die Endbenutzer, die auf den Computern bei Bedarf manuell
installieren konnen.

Ubertragen der Installation unter Windows auf lokale Desktop-Computer

Da IBM SPSS Amos-Installationen mit Microsoft Windows Installer (MSI) kompatibel sind, kénnen Sie die
Installation automatisch auf die Desktop-Computer der Endbenutzer iibertragen.

Ubertragen einer Installation an Windows-Computer

Das Ubertragen einer Installation ist eine Methode fiir die Fernverteilung von Software an eine beliebige
Zahl von Endbenutzern, ohne dass die Benutzer aktiv werden miissen. Sie konnen eine vollstindige Ins-
tallation von IBM SPSS Amos auf die Computer der Endbenutzer unter Windows iibertragen. Die fiir die
automatische Ubertragung der Installation verwendete Technologie muss die MSI 3,0-Engine oder hoher

unterstiitzen.

Deinstallieren einer friiheren Version

Wenn Sie die automatische Ubertragung in ein Verzeichnis durchfiihren, in dem eine friihere Version von
IBM SPSS Amos installiert wurde, muss die alte Version deinstalliert werden. Sie konnen die Deinstallati-
on ebenso wie eine Installation libertragen. Weitere Informationen finden Sie im Thema
Ubertragung einer Deinstallation” auf Seite 13|

Eigenschaften fur automatisch libertragene Installationen

Nachfolgend finden Sie die Eigenschaften, die fiir automatisch iibertragene Installationen verwendet wer-
den konnen. Bei allen Eigenschaften wird zwischen Grof3- und Kleinschreibung unterschieden. Werte
miissen in Anfiihrungszeichen angegeben werden, wenn sie Leerzeichen enthalten.
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Tabelle 1. Eigenschaften fir automatisch (bertragene Installationen.

Eigenschaft Beschreibung Giiltige Werte Standard (sofern zutref-
fend)
INSTALLDIR Das Verzeichnis, in dem Ein giiltiger Pfad, beispiels- | C:\Program Files\IBM\
IBM SPSS Amos auf dem weise C:\ Amos. SPSS\AMOS\24

Desktop-Computer des
Endbenutzers installiert
werden sollte. Diese Eigen-
schaft ist optional. Wird sie
nicht angegeben, wird der
Standardwert C:\Program
FilesN\IBM\SPSS\AMOS\24
verwendet.

LICENSETYPE Der Lizenztyp. Bei diesem |Network
Wert wird zwischen Grofs-
und Kleinschreibung unter-
schieden.

LSHOST Die IP-Adresse oder der Eine oder mehrere giiltige
Name des Computers bzw. |IP-Adressen oder Namen
der Computer im Netz, auf |der Computer im Netz.

dem bzw. denen der Mehrere Adressen oder Na-
Concurrent License Mana- | men werden durch Tilden
ger ausgefiihrt wird. getrennt (z. B.
Server~Server2~Server3).
DISABLE_COMMUTE Inaktiviert die 1 gibt an, dass die 1

Pendlerlizenzfunktion auf |Pendlerlizenzen inaktiviert
dem Desktop-Computer sind.

des Endbenutzers. Wenn 0 gibt an, dass die
Pendlerlizenzen aktiviert Pendlerlizenzen aktiviert
sind, werden auf dem sind.

Desktop-Computer keine
Verkniipfungen fiir
Pendlerlizenzen installiert.
Weitere Informationen zu
Pendlerlizenzen finden Sie
in [, Konfigurieren von|
Pendlerlizenzen” auf Seite|
1q
COMMUTE_MAX_LIFE Die maximale Anzahl von |Eine Zahl zwischen 1 und |7
Tagen, fiir die ein 30.
Endbenutzer eine
Pendlerlizenz auschecken
kann. Weitere Informatio-
nen finden Sie im Thema

| Konfigurieren von|
Pendlerlizenzen” auf Seite]
16]

COMPANYNAME Der Name Thres Unterneh- |Eine beliebige Zeichenfolge.
mens.

MSI-Dateien

Die Datei IBM SPSS Amos 24.msi befindet sich im Verzeichnis Windows\ Amos auf der DVD/CD. Nach-
dem Sie die Software heruntergeladen haben, miissen Sie den Inhalt des elmage entpacken, um auf die
MSI-Datei zugreifen zu kénnen.
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Beispiel fiir die Befehlszeile
Nachfolgend finden Sie eine Befehlszeile zur automatischen Ubertragung einer Produktinstallation. Geben
Sie den gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /i "IBM SPSS Amos 24.msi" /qn /Lxv Togfile.txt
INSTALLDIR="C:\Amos" LICENSETYPE="Network" LSHOST="mylicserver"

Automatisches Ubertragen der Installation mithilfe von SMS
Die grundlegenden Schritte fiir die Verwendung von Systems Management Servers (SMS) fiir die automa-
tische Ubertragung (Push) von IBM SPSS Amos sind folgende:

1. Kopieren Sie das entsprechende Unterverzeichnis des Verzeichnisses Windows\Amos auf der DVD/CD
in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software heruntergeladen haben, miissen
Sie den Inhalt des elmage zundchst entpacken.

2. Bearbeiten Sie die Datei IBM SPSS Amos 24.sms im kopierten Verzeichnis. Bearbeiten Sie mithilfe eines
Texteditors den Wert von "CommandLine", indem Sie die entsprechenden Eigenschaften hinzufiigen.
Eine Liste der verfiigbaren Eigenschaften finden Sie in [,Eigenschaften fiir automatisch iibertragene|
[Installationen” auf Seite 10] Stellen Sie sicher, dass Sie die richtige MSI-Datei in der Befehlszeile ange-
ben.

3. Erstellen Sie ein Paket aus der Datei IBM SPSS Amos 24.sms und verteilen Sie das Paket an die Desk-
top-Computer der Endbenutzer.

Verwenden von Gruppenrichtlinie oder einer @hnlichen Technologie zur automati-

schen Ubertragung der Installation

1. Kopieren Sie das entsprechende Unterverzeichnis des Verzeichnisses Windows\Amos auf der DVD/CD
in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software heruntergeladen haben, miissen
Sie den Inhalt des elmage zunédchst entpacken.

2. Mit einer Anwendung wie ORCA konnen Sie die Eigenschaftstabelle in der entsprechenden Datei IBM
SPSS Amos 24.msi unter dem kopierten Ordner bearbeiten. ORCA ist Teil des Windows 2003 Server
SDK, das Sie unter http:/ /www.microsoft.com/downloads| finden, indem Sie nach dem SDK suchen.
Eine Liste der Eigenschaften, die in die Eigenschaftstabelle aufgenommen werden konnen, finden Sie
in |, Eigenschaften fiir automatisch iibertragene Installationen” auf Seite 10l Achten Sie darauf, dass Sie
die richtige MSI-Datei verwenden.

3. Erstellen Sie ein Paket aus der bearbeiteten Datei IBM SPSS Amos 24.msi und verteilen Sie das Paket
an die Desktop-Computer der Endbenutzer.

Automatische Ubertragung der Installation auf ein nicht englisches System

Sie konnen sie ohne zusétzliche Spezifikation auf ein nicht englisches System tiibertragen. Allerdings sind
dann die Installationsanweisungen (bei der Ubertragung einer interaktiven Installation), die Benutzer-
schnittstelle und die Hilfe auf Englisch. Die Anwender kénnen nach der Installation die Benutzerschnitt-
stellensprache umstellen, es steht jedoch keine lokalisierte Hilfe zur Verfiigung.

Sie konnen die Eigenschaft TRANSFORMS verwenden, um eine der MST-Dateien anzugeben, die auf der
DVD/CD oder im heruntergeladenen elmage vorhanden sind. Die MST-Datei stellt sicher, dass der Instal-
lationsassistent, die Benutzerschnittstelle und die Hilfe in der spezifizierten Sprache erscheinen. MST-Da-
teien sind nicht verfligbar, wenn Sie IBM SPSS Amos heruntergeladen haben. Benutzer miissen die
Sprachpakete fiir die lokalisierte Hilfe manuell installieren und die Benutzerschnittstellensprache in dem
Produkt manuell d&ndern.

Die Eigenschaft TRANSFORMS ist ein Parameter fiir MsiExec.exe. Das folgende Beispiel verwendet die Eigen-
schaft TRANSFORMS zur automatischen Ubertragung einer franzosischen Installation. Der Installationsassis-
tent erscheint auf franzosisch, die Benutzerschnittstelle erscheint auf franzosisch und die Hilfe wird auf
franzosisch installiert. (Sie konnen die Sprache der Hilfefunktion auch mit der Eigenschaft HELPCHOICE
iiberschreiben. Weitere Informationen finden Sie im Thema |, Eigenschaften fiir automatisch iibertragene|
[nstallationen” auf Seite 10|) Geben Sie den gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /i "IBM SPSS Amos 24.msi" /qn /L*v Protokolldatei.txt
INSTALLDIR="C:\Amos" LICENSETYPE="Network" LSHOST="mylicserver" TRANSFORMS=1036.mst
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Die folgenden Sprach-MST-Dateien befinden sich im Verzeichnis Windows\Amos auf der DVD/CD. Wenn
Sie ein elmage heruntergeladen haben, befinden sich diese Dateien im Stammverzeichnis der entpackten
elmage-Dateien.

Tabelle 2. MST-Sprachdateien.

Sprache MST-Datei
Englisch 1033.mst
Japanisch 1041.mst

Automatische Ubertragung einer Deinstallation

Hinweis: Wenn Sie den Deinstallationsbefehl automatisch iibertragen, gehen die Anpassungen der Endbe-
nutzer verloren. Wenn bestimmte Benutzer ihre Anpassungen benétigen, konnen Sie diese aus der Vertei-
lung ausschliefien und sie bitten, das Produkt manuell zu installieren.

Wenn Sie eine Installation einer neueren Version von IBM SPSS Amos automatisch iibertragen, sollten Sie
gegebenenfalls zuerst eine Deinstallation durchfiihren. Sie kénnen dies im Hintergrund durchfiihren las-
sen, indem Sie den folgenden Befehl durch einen Push-Vorgang automatisch iibertragen. Geben Sie den
gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /X{A24026D3-0EOB-49F1-8FC8-65E254EB421F} /qn /Lxv Protokolldatei.txt
ALLUSERS=1 REMOVE="ALL"

Dieser Befehl deinstalliert IBM SPSS Amos 24. In der folgenden Tabelle sind die Deinstallations-IDs fiir
diese und friihere Versionen aufgelistet.

Tabelle 3. Deinstallations-IDs fiir IBM SPSS Amos.

Version | Deinstallations-ID

24.% A24026D3-0E0B-49F1-8FC8-65E254EB421F}
23.% 2B603859-DCA2-45DD-92DF-98542E78BA A8}
22.% DEB57287-C937-4DE9-939A-5ED3ABSF052D}
21.% 304B71E3-1017-4717-86BC-F1D18519FEF2}

{
{
{
{
20.* {58C50F5A-B7E2-4149-8911-B14CEC825F57}
{
{
{
{

19.* B132EFD2-BF03-48 A A-8EC8-404E4C5199C5}
18.* 65D9DA69-4C22-46CA-B762-A338CAC94599}
17.* 9DB2E18E-2A1F-4D65-A258-9CB446903C3E}
16.* 4DA782CB-C9A0-462F-9D18-17D301BC507C}

Verwalten der Lizenz fiir gleichzeitig angemeldete Benutzer

Der Lizenzmanager verwaltet die Lizenz fiir gleichzeitig angemeldete Benutzer. Mithilfe der Anwendung
WImAdmin, die die Hauptbenutzeroberflache fiir den Lizenzmanageradministrator ist, konnen Sie den
Lizenzmanager verwalten und Informationen zu den verwalteten Lizenzen fiir gleichzeitig angemeldete
Benutzer anzeigen. Der Lizenzmanageradministrator wird unter Windows automatisch zusammen mit
dem Concurrent License Manager installiert. Wenn Sie einen Lizenzmanager auf einem Nicht-Windows-
System oder einem Remote-Windows-System verwalten, installieren Sie den Lizenzmanageradministrator
auf einem separaten Windows-System. Weitere Informationen finden Sie im Thema |, Installieren des|
Lizenzmanageradministrators” auf Seite 4}

Hinweis: Weitere Informationen zur Administration finden Sie in der SafeNet-Dokumentation, die zusam-
men mit dem Lizenzmanageradministrator installiert wird. Diese Dokumentation finden Sie im Unterver-
zeichnis Content des Installationsverzeichnisses des Lizenzmanageradministrators (z. B.C:\Programme\
IBM\SPSS\Concurrent Licensing Tools\9.5.0\License Manager Administrator\Content).
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Starten der Anwendung WImAdmin
Auf einem Windows-Computer, auf dem der Lizenzmanager installiert ist:

1. Wabhlen Sie folgende Befehle aus dem Menii "Start" von Windows aus: [Alle] Programme > IBM
SPSS Concurrent Licensing Tools - License Manager<Version> > Sentinel RMS License Server Ad-
ministration

Auf einem Windows-Computer, auf dem die Tools fiir den Lizenzmanager installiert sind:

1. Waihlen Sie folgende Befehle aus dem Menii "Start" von Windows aus: [Alle] Programme > IBM
SPSS Concurrent Licensing Tools - License Manager Administrator <Version> > Sentinel RMS Li-
cense Server Administration

Hinzufligen eines Servers

Bevor Sie einen Lizenzmanager verwalten konnen, miissen Sie in der Anwendung WImAdmin einen Ser-
ver dafiir hinzufiigen. Sie haben zwei Optionen, um den Server hinzuzufiigen.

Manuelles Hinzufligen eines Servers
1. Waibhlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Defined Server List

2. Geben Sie in dem Dialogfeld "Defined Server List" den Namen oder die IP-Adresse des Servers ein,
auf dem der Lizenzmanager lduft.
3. Klicken Sie auf Add.

4. Klicken Sie auf OK.

Der Server wird jetzt in den Listen der Server im linken Fensterbereich der Anwendung WImAdmin an-
gezeigt.

Anzeigen einer Liste der Server im Teilnetz

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Subnet
Servers.

Eine Liste von Servern fiir Lizenzmanager in Ihrem Teilnetz wird angezeigt. Wenn Sie einen bestimmten
Server mit diesem Verfahren nicht finden, fiigen Sie ihn wie oben beschrieben manuell hinzu.

Abrufen von Protokollinformationen

Wenn Endbenutzer beim Abruf von Lizenzen Schwierigkeiten haben, kénnen die Protokolldateien mogli-
cherweise hilfreiche Informationen enthalten. Sie konnen die Umgebungsvariable LSERVOPTS sowie die
Optionen -f <Traceprotokolldatei> und -1 <Nutzungsprotokolldatei> verwenden, um anzugeben, dass
Protokolldateien erstellt werden sollen. Weitere Informationen zu dieser Umgebungsvariablen und den
zugehorigen Optionen finden Sie in der SafeNet-Dokumentation im Verzeichnis Content des Installations-
verzeichnisses des Lizenzmanageradministrators.

Anzeigen der Details zu einer Lizenz

Sie konnen Details zu Lizenzen anzeigen, die Sie entweder manuell oder iiber den Lizenzierungsassisten-
ten hinzugefiigt haben.

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Lizenzma-
nagerserver, um die Lizenz(en) anzuzeigen.

2. Klicken Sie auf den Namen der Lizenz. Im rechten Fensterbereich werden Details zu der Lizenz ange-
zeigt. Die Lizenzen werden mithilfe von Codes identifiziert. Der erste Teil des Codes verweist auf die
Funktion. Der zweite Teil verweist auf die Version.
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Anzeigen der mit den Funktionscodes verkniipften Namen

1. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-
nistrators.

2. Geben Sie Tmshowlic <Server> (Windows) oder ./Imshowlic <Server> (andere Betriebssysteme) ein.
Dabei stellt <Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausge-
fuhrt wird.

In der Ausgabe werden alle Funktionen nach Produkt und Version in Gruppen geordnet aufgefiihrt, die
auf dem Server verfiigbar sind.

Einrichten von redundanten Lizenzservern

Sie konnen mehrere redundante Lizenzserver einrichten, die dieselben Benutzer unterstiitzen. Mit redun-
danten Servern koénnen Sie Unterbrechungen verhindern, die durch den Absturz eines Servers bedingt
sind. Im Falle eines Serverabsturzes kann ein anderer redundanter Server die Lizenzverwaltung tiberneh-
men.

Fiir die in den folgenden Schritten beschriebene Aktivierung der Redundanzfunktion benétigen Sie einen
speziellen Lizenzcode. Wenden Sie sich fiir Unterstiitzung beim Erstellen eines redundanten Lizenzschliis-
sels oder bei anderen Fragen zur Lizenzierung telefonisch oder per Mail an den IBM Support. Kontaktin-
formationen finden Sie unter |http:/ /www.ibm.com/planetwide]

Es muss eine ungerade Anzahl von Servern (mindestens drei) vorhanden sein und die Mehrzahl der Ser-
ver muss jeweils gleichzeitig ausgefiihrt werden. Wenn zum Beispiel drei redundante Lizenzserver exis-
tieren, miissen von diesen zwei ausgefiihrt werden.

Vorbereiten der einzelnen redundanten Lizenzserver

1. Installieren Sie den Lizenzmanager. Weitere Informationen finden Sie im Thema |, Installieren des Con-|
fcurrent License Managers” auf Seite 2|

2. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

3. Rufen Sie den Sperrcode fiir die einzelnen Server-Computer ab. Geben Sie an der Eingabeaufforde-
rung echoid (Windows) bzw. ./echoid (anderes Betriebssystem) ein.

4. Notieren Sie den Sperrcode. Fiir die ndchsten Schritte ist der Sperrcode erforderlich.
5. Wiederholen Sie diese Schritte fiir jeden redundanten Lizenzserver.

Aktivieren der redundanten Lizenzen
1. Rufen Sie das IBM SPSS License Key Center auf (https://spss.subscribenet.com/control/ibmp/login).
2. Erstellen Sie einen Autorisierungscode fiir gleichzeitig angemeldete Benutzer.

3. Klicken Sie nach der Erstellung des Autorisierungscodes fiir gleichzeitig angemeldete Benutzer auf
den Code und bldttern Sie nach unten, bis die Felder fiir Sperrcode angezeigt werden. Nun kénnen
Sie dem Lizenzschliissel mehrere Sperrcodes hinzuftigen.

4. Geben Sie die Sperrcodes aus den vorherigen Schritten in die entsprechenden Felder ein.
5. Klicken Sie auf Ubergeben.

Einrichten eines Pools mit redundanten Lizenzservern

1. Wenn auf einem oder mehreren redundanten Lizenzservern ein Lizenzmanager ausgefiihrt wird, be-
enden Sie diesen auf jedem betroffenen Computer.

2. Wihlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Redundant License File
Dadurch wird die Anwendung WrlfTool geoffnet.

3. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WrlfTool aus:
File > New
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4. Klicken Sie fiir jeden redundanten Lizenzserver auf Add, um jeweils den Hostnamen und die IP-Ad-
resse anzugeben.

5. Ordnen Sie die redundanten Lizenzserver in der Reihenfolge an, in der sie verwendet werden sollen.
Der erste Server in der Liste ist der primére Server.

6. Klicken Sie auf Add License, um die Lizenzen hinzuzufiigen, die Sie vom Kundendienst oder IThrer
lokalen Niederlassung erhalten haben. Achten Sie bei mehreren Lizenzen darauf, dass Sie auch wirk-
lich alle hinzugefiigt haben.

7. Klicken Sie auf OK.
8. Klicken Sie abschliefSend auf Done.

Speichern der redundanten Lizenzdatei
1. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WrlfTool aus:
File > Save As

2. Speichern Sie die redundante Lizenzdatei (Iservrlf) an einem leicht zugédnglichen Speicherort. In den
ndchsten Schritten miissen Sie die Datei kopieren.

Konfigurieren der redundanten Lizenzserver

1. Kopieren Sie die redundante Lizenzdatei (Iservrlf) unter Windows in den Unterordner winnt des Li-
zenzmanagerinstallationsverzeichnisses. Wenn Sie den Standardspeicherort akzeptiert haben, wechseln
Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager.
Auf anderen Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsver-
zeichnis. Es miissen mindestens drei redundante Lizenzserver vorhanden sein.

2. Starten Sie auf allen redundanten Lizenzservern den Lizenzmanager.
Konfigurieren des Computers des Endbenutzers

Wenn ein Endbenutzer das Produkt installiert, gibt der Benutzer alle redundanten Server an. Die Namen
oder IP-Adressen der Server werden dabei durch Tilden getrennt (z. B. Serverl~Server2~Server3). Das
Setup-Programm fiigt dann dem Computer des Endbenutzers die erforderlichen Konfigurationsinformati-
onen hinzu. Wenn das Produkt bereits auf den Computern installiert ist, konnen Sie die folgenden Schrit-
te ausfithren, um die Konfigurationsinformationen hinzuzufiigen. Sie konnen auch zunéchst eine Deins-
tallation und anschlieffend eine neue Installation iibertragen, bei der alle Server festgelegt sind.
Informationen zum automatischen Ubertragen von Installationen finden Sie in [,Ubertragen einer Installa-|
tion an Windows-Computer” auf Seite 10|

1. Offnen Sie die Datei spssprod.inf in einem Texteditor. Unter Windows befindet sich diese Datei auf
dem Desktop-Computer im Installationsverzeichnis des Produkts.

2. Andern Sie den Wert von DAEMONHOST in die durch eine Tilde (~) getrennten Namen oder IP-Adressen
des Servers. Beispiel:
DAEMONHOST=Serverl™~Server2™Server3

3. Speichern Sie spssprod.inf.

Konfigurieren von Pendlerlizenzen

Mit Pendlerlizenzen konnen Endbenutzer Lizenzen aus dem Lizenzmanager auschecken, sodass sie diese
Lizenzen verwenden konnen, auch wenn sie nicht mit dem Netz verbunden sind. Unter Windows sind
Pendlerlizenzen standardmaflig nicht aktiviert. Auf anderen Betriebssystemen sind sie dagegen standard-
maflig aktiviert. Anweisungen fiir das eigentliche Auschecken der Pendlerlizenz finden sich in den Instal-
lationshinweisen fiir Endbenutzer.

Sie kénnen den Prozentsatz der Lizenzen auf dem Lizenzmanagerserver beschranken, die fiir den mobi-
len Zugriff aktiviert werden. Es empfiehlt sich, die Anzahl der Pendlerlizenzen zu beschranken. Damit
wird verhindert, dass sich alle verfiigbaren Lizenzen im mobilen Einsatz befinden. Wenn der angegebene
Prozentsatz an Lizenzen von mobilen Anwendern aufgebraucht wurde, stehen keine weiteren Lizenzen
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zur Verfiigung, bis die mobilen Lizenzen ablaufen oder wieder eingecheckt werden. Sie konnen auflerdem
die Dauer festlegen, fiir die mobile Lizenzen ausgecheckt werden kénnen. In der Standardeinstellung be-
tragt die maximale Dauer 7 Tage.

Wichtig: Wenn Sie redundante Lizenzserver mit Pendlerlizenzen verwenden, gestattet nur der primére
Lizenzserver den Benutzern, Pendlerlizenzen aus- und einzuchecken. Bei einem Ausfall des priméren Li-
zenzservers konnen die Benutzer keine Lizenzen ein- und auschecken.

Festlegen des Prozentsatzes der verfligbaren Pendlerlizenzen

1. Erstellen Sie auf dem Lizenzmanagerserver eine Umgebungsvariable mit dem Namen LSERVOPTS. Die-
se Variable wird unter Windows wéhrend der Lizenzmanagerinstallation erstellt, sodass Sie diesen
Schritt nur fiir die anderen Betriebssysteme durchfiihren miissen.

2. Andern Sie den Wert der Umgebungsvariablen LSERVOPTS, indem Sie -com <Prozentsatz> aufnehmen.
Hierbei stellt <Prozentsatz> einen numerischen Wert zwischen 0 und 100 dar, der den Prozentsatz an
Lizenzen angibt, die fiir den mobilen Zugriff verfiigbar sind. Mit der Angabe 0 stehen keine Lizenzen
fiir den mobilen Zugriff zur Verfiigung. Dieser Schalter ist unter Windows standardmafig enthalten
und auf 0 festgelegt.

3. Starten Sie den Computer neu, auf dem der Lizenzmanager ausgefiihrt wird.
Festlegen der maximalen Zeitdauer fir Pendlerlizenzen

Die maximale Zeitdauer, fiir die die Endbenutzer eine Pendlerlizenz auschecken konnen, wird durch die
Einstellung CommuterMaxLife in der Datei spssprod.inf auf dem Desktop-Computer angegeben. Unter Win-
dows befindet sich diese Datei auf dem Desktop-Computer im Installationsverzeichnis des Produkts. Off-
nen Sie die Datei spssprod.inf und suchen Sie nach CommuterMaxLife . Legen Sie den Wert dieser Option
auf die maximale Anzahl von Tagen fest, fiir die die Endbenutzer eine Pendlerlizenz auschecken kénnen.
Der Wert sollte eine Zahl zwischen 1 und 30 sein. Sie konnen diesen Wert auch festlegen, wenn Sie die
Installation automatisch iibertragen. Weitere Informationen finden Sie im Thema |, Ubertragen einer Instal-|
lation an Windows-Computer” auf Seite 10}

Hinweis: Diese Funktion arbeitet mit einer Datums-, nicht mit einer Zeitangabe. Wenn Sie zum Beispiel
die Option CommuterMaxLife auf einen Tag setzen und dann eine Lizenz um 9.00 Uhr auschecken, wird
diese Lizenz nicht vor Mitternacht des Folgetages wieder eingecheckt. Auch wenn also CommuterMaxLife
auf einen Tag eingestellt ist, behilt der Benutzer die Lizenz tatsdchlich 39 Stunden lang.

Abrufen einer Liste der ausgecheckten Lizenzen in der Befehlszeile

Sie kénnen ermitteln, welche Benutzer Lizenzen ausgecheckt haben.

1. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-
nistrators.

2. Geben Sie Ismon<Server> (Windows) oder ./1smon <Server> (andere Betriebssysteme) ein. Dabei stellt
<Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausgefiihrt wird.
Sie kénnen den Namen des Lizenzservers auslassen, wenn Sie nur die ausgecheckten Lizenzen fiir
den Server "localhost" anzeigen mdochten.

Abrufen einer Liste der ausgecheckten Lizenzen in der Anwendung WimAdmin

Sie kénnen ausgecheckte Lizenzen auch in der Anwendung WImAdmin anzeigen:

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben dem Li-
Zenzmanagerserver.

2. Klicken Sie auf das Zeichen + neben Clients. Die Clients, die die Lizenz fiir gleichzeitig angemeldete
Benutzer nutzen, werden aufgelistet. Wenn keine Clients aufgelistet werden, verwendet kein Benutzer
die Lizenz fiir gleichzeitig angemeldete Benutzer.
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3. Waihlen Sie einen bestimmten Client aus, um anzuzeigen, ob der Client eine Lizenz ausgecheckt hat.
Uberpriifen Sie nach der Auswahl den Bereich "Detaillierte Informationen" im rechten Fensterbereich.

Konfigurieren von Lizenzreservierungen

Sie kénnen eine Reservierungsdatei erstellen, in der angegeben wird, wie viele Lizenzen fiir bestimmte
Benutzer oder Benutzergruppen reserviert werden. Die Benutzer werden durch Netz-IDs oder Compu-
ternamen (nicht durch IP-Adressen) identifiziert. Sie konnen zum Beispiel eine Reservierungsdatei einrich-
ten, mit der die Lizenz fiir eine Gruppe von Hauptbenutzern reserviert wird. Fiir diese Benutzer werden
die Lizenzen immer verfiigbar sein. Mithilfe der Reservierungen kénnen Sie auch verhindern, dass be-
stimmte Benutzer einen Zugriff auf die Lizenz bekommen.

Erstellen einer neuen Reservierungsdatei
1. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Reservation File
Dadurch wird die Anwendung Wlsgrmgr geoffnet.
2. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung Wlsgrmgr aus: File > New.

Hinzufligen von Lizenzen und Benutzer zur Reservierungsdatei

1. Wahlen Sie die folgenden Befehle aus den Mentis der Anwendung Wlsgrmgr aus:
Feature > Add

2. Klicken Sie im ersten Bildschirm des Assistenten auf Weiter.

3. Geben Sie den Funktionscode fiir die entsprechende Lizenz an, die Sie reservieren méchten. Informati-
onen zum Abrufen der Funktionscodes fiir die entsprechenden Lizenzen finden Sie in
[Details zu einer Lizenz” auf Seite 14} Legen Sie auerdem eine bestimmte Version fest. Geben Sie die
Version hierbei so ein, wie sie in der Anwendung WIAdmin angezeigt wird (z. B. 160). Die Version ist
nicht optional. Ignorieren Sie die Steuerelemente fiir "Capacity", weil Lizenzen dieses Typs nicht un-
terstiitzt werden.

4. Klicken Sie auf Weiter.

5. Geben Sie fiir die Gruppe von Benutzern einen Namen an. Der Name ist willkiirlich, er sollte jedoch
aussagekréftig sein (z. B. Vertrieb).

6. Geben Sie die Anzahl der Lizenzen an, die fiir diese Gruppe reserviert werden sollen. Die Gruppen-
mitglieder konnen auf alle Lizenzen zugreifen. Die Anzahl von Lizenzen, die Sie angeben, steht je-
doch nicht mehr fiir die Benutzer zur Verfiigung, die nicht Mitglied dieser Gruppe sind. Dies bedeu-
tet: Wenn Sie von 10 Lizenzen 5 Lizenzen reservieren, konnen Mitglieder dieser Gruppe iiber 10
Lizenzen verfiigen, wiahrend den anderen Benutzern nur 5 Lizenzen zur Verfligung stehen.

7. Klicken Sie im Fenster "Members" auf Add, um einen der Gruppe zugehorigen Benutzer oder Compu-
ternamen (keine IP-Adressen verwenden) anzugeben. Benutzer und Computer, die der Gruppe ange-
horen, konnen die reservierten Lizenzen verwenden. Benutzer und Computer, die der Gruppe nicht
angehoren, konnen nicht auf die reservierten Lizenzen zugreifen. Geben Sie so viele Benutzer und
Systeme wie erforderlich an. Beachten Sie, dass sich die Gruppen gegenseitig ausschlieffen miissen.
Daher kénnen verschiedenen Gruppen fiir dieselbe Lizenz nicht dieselben Benutzer oder Computer
enthalten.

8. Klicken Sie auf Fertigstellen, wenn Sie der Gruppe alle Benutzer hinzugefiigt haben.

9. Fiigen Sie nach Bedarf weitere Gruppen oder Lizenzen hinzu. Sie kédnnen Lizenzen und Gruppen
auch dndern oder 16schen, indem Sie auf diese mit der rechten Maustaste klicken und die Option Pro-
perties auswéhlen.

Speichern der Reservierungsdatei

1. Waihlen Sie folgenden Befehle aus den Meniis aus, wenn Sie die Reservierungsdatei fertiggestellt ha-
ben:

File > Save As
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2. Speichern Sie die Datei an einem leicht zugdnglichen Speicherort. Im nédchsten Schritt miissen Sie die
Datei kopieren.

3. Um die Einstellung zu aktivieren, dass der Lizenzserver die Datei Isreserv beim Start automatisch fin-
det, kopieren Sie die Datei unter Windows in den Unterordner winnt im Lizenzmanagerinstallations-
verzeichnis. Wenn Sie den Standardspeicherort akzeptiert haben, wechseln Sie in den Ordner C:\
Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager. Auf anderen
Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsverzeichnis.

4. Wenn Sie allen redundanten Servern dieselben Reservierungen zuweisen mochten, kopieren Sie die
Reservierungsdatei (Isreserv) auf jeden Server.

5. Starten Sie abschlieflend jeden Lizenzmanager neu.

Starten und Stoppen des Lizenzmanagers

Die Methode zum Starten des Lizenzmanagers hangt von Ihrem Betriebssystem ab.
Windows

Auf Windows-Computern wird der Lizenzmanager als Systemdienst ausgefiihrt. Der Dienst wird stan-
dardmaéfig automatisch gestartet. Falls Sie ihn dennoch einmal manuell starten miissen, gehen Sie wie
folgt vor:

1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.

2. Doppelklicken Sie auf Dienste.

3. Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.
4.

Klicken Sie mit der rechten Maustaste auf den Dienst und wéhlen Sie die Option Starten oder Been-
den aus.

Andere Betriebssysteme

Auf anderen Betriebssystemen wird der Lizenzmanager als Damonprozess ausgefiihrt. Fiihren Sie zum
manuellen Starten die folgenden Schritte aus. Sie konnen den Lizenzmanager auch zum automatischen
Starten konfigurieren (Anweisungen folgen).

1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

2. Starten. Geben Sie als Root an der Eingabeaufforderung ./1serv & ein und driicken Sie die Eingabe-
taste.

3. Beenden. Geben Sie als Root ./1srvdown <Hostname> an der Eingabeaufforderung ein, wobei <Hostna-
me> der Netzname des Computers ist, auf dem der Lizenzmanager ausgefiihrt wird. Driicken Sie
dann die Eingabetaste.

Konfigurieren des Lizenzmanagers fur den automatischen Start
Windows

1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.

Doppelklicken Sie auf Dienste.

Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.

Klicken Sie mit der rechten Maustaste auf den Dienst und wéhlen Sie die Option Eigenschaften aus.
Legen Sie als "Starttyp" Automatisch fest.

Klicken Sie auf OK.

IS S o < A

Andere Betriebssysteme

1. Figen Sie einer der Startdateien des Betriebssystems den Eintrag ./1serv & hinzu.
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Deinstallieren des Lizenzmanagers
Windows

1.

4.
5.
6.

Wahlen Sie folgende Befehle aus dem Menti "Start" von Windows aus:
Einstellungen > Systemsteuerung
Doppelklicken Sie auf Software.

Wiéhlen Sie den Eintrag IBM SPSS Concurrent Licensing Tools - License Manager aus und klicken
Sie dann auf Entfernen.

Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.
Wihlen Sie Sentinel RMS License Manager und klicken Sie anschliefend auf Entfernen.

Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.

Andere Betriebssysteme

1.
2.

3.

Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

Beenden Sie den Lizenzmanager, indem Sie als Root an der Eingabeaufforderung ./Tsrvdown
<Hostname> eingeben, wobei <Hostname> der Netzname des Computers ist, auf dem der Lizenzmana-
ger ausgefiihrt wird. Driicken Sie dann die Eingabetaste.

Loschen Sie das Installationsverzeichnis des Lizenzmanagers.

Deinstallieren des Lizenzmanageradministrators
Windows

1.

4.

Wihlen Sie folgende Befehle aus dem Menii "Start" von Windows aus:
Einstellungen > Systemsteuerung
Doppelklicken Sie auf Software.

Waihlen Sie den Eintrag IBM SPSS Concurrent Licensing Tools - License Manager Administrator aus
und klicken Sie dann auf Entfernen.

Klicken Sie auf Ja, wenn Sie aufgefordert werden, die parallelen Lizenzierungstools zu entfernen.

Andere Betriebssysteme

1.

Loschen Sie das Installationsverzeichnis des Lizenzmanageradministrators.

Fehlerbehebung bei Problemen mit den Desktop-Computern

Gehen Sie folgendermafien vor, wenn die Desktop-Computer der Endbenutzer den Lizenzmanager nicht
finden kénnen:

1.

Fiihren Sie 1swhere aus, um zu iiberpriifen, ob der Desktop-Computer den Netzcomputer finden
kann, auf dem der Lizenzmanager ausgefiihrt wird. Weitere Informationen finden Sie im Thema
[, Ausfithren von "Iswhere"”}

Stellen Sie sicher, dass der Lizenzmanagerservice auf dem Netzcomputer ausgefiihrt wird.

Uberpriifen Sie die entsprechende Datei spssprod.inf. Unter Windows befindet sich diese Datei auf dem
Desktop-Computer im Installationsverzeichnis des Produkts. Offnen Sie die Datei spssprod.inf und ver-
gewissern Sie sich, dass fiir DAEMONHOST der richtige Name bzw. die richtige IP-Adresse des Computers
festgelegt ist, auf dem der Lizenzmanager ausgefiihrt wird. Wenn Sie redundante Server verwenden,
miissen hier alle Server definiert sein. Die einzelnen Namen werden durch eine Tilde () getrennt.
Wenn es sich beispielsweise bei den Lizenzmanagercomputern um SERVER1, SERVER2 und SERVER3
handelt, wird DAEMONHOST auf SERVER1VSERVER2VSERVER3 gesetzt.

Ausfihren von "Iswhere"
Iswhere kann iiber den Desktop-Computer eines Endbenutzers ausgefiihrt werden, um zu ermitteln, auf
welchem Computer der Concurrent License Manager ausgefiihrt wird.

1.
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2. Geben Sie 1swhere ein.

Service und Support

Um den Technical Support von IBM zu kontaktieren, rufen Sie lhttp:/ /www.ibm.com /support| auf und
senden Sie eine Fallbeschreibung. Sie miissen sich beim Technical Support von IBM registrieren, falls Sie
das nicht schon friiher getan haben.

IBM bietet aufSerdem regelmafsig 6ffentliche Schulungsseminare fiir IBM Produkte. Die Ausbildung kann
auch bei Ihnen vor Ort erfolgen. Informationen zu Schulungsseminaren finden Sie unter
www.ibm.com /training /spss}
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